Learning Support Guide
During Remote Learning
(For Parents)



Netherthorpe School — Learning Support Guide for use during Remote
Learning

This guide has been put together to signpost students to technology and resources to support their
learning, when working remotely.
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Student Drop In

Parent Drop In

‘Speak’ in Powerpoint

Immersive Reader in Microsoft Word
Immersive Reader in Microsoft Teams
Dictate Function

Color Vell

Additional Resources and Support
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1. Learning Support

Netherthorpe School will use reasonable endeavours to replicate school support for SEND
students as far as possible during any closure.

For students with GRIP or an EHCP:
At Netherthorpe, every student with GRIP funding or an EHCP has an allocated Key Worker Teaching
Assistant. In the event of a class or year group closure:

e TAs will be available to support students during live lessons and teachers may choose to direct
identified students to work with the TA in a break out room, where they deem it appropriate.

o Key worker TAs will look at the work provided for their key students every day on Show My
Homework and will contact their students regularly to offer remote learning guidance. This call will
focus on learning support specific to the tasks set by the class teacher and will be an
opportunity for students to ask questions and clarify any misconceptions. Ideally, these calls
should take place over Microsoft Teams, however if students are unable to engage with a Teams
meeting, learning support can be offered via a telephone call and a dialogue created via email so
students can send work and receive feedback.

e Where students identify difficulties with the task, TAs will coach the student through the task
remotely and support them to engage with their learning. Where difficulties cannot be resolved
within the learning support meeting/call, TAs will contact the class teacher to explore any
resources or support that could be offered to the student. Where applicable, the TA may ask the
class teacher to contact the student to offer targeted and specialist remote support.

e Any student in receipt of an intervention (IDL, Social Bridges, Precision Teaching) will still receive
their intervention as normal, either face to face in school or via a Microsoft Teams meeting,
following discussion with the intervention teacher, parent and student.



2. Student Drop In

In addition to the learning support offered during live lessons and individual learning support calls,
students have the opportunity to attend our ‘student drop in’ service every day from 12-1pm. This is an
opportunity for students to ask any questions and seek support with their learning from our teaching
assistants, assistant SENDCO and/or SENDCO.

The guide below describes how to attend the student drop in:

1. In Microsoft Teams, click on the ‘Learning Support’ Team.
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3. Alternatively, you will see ‘Learning Support Student Drop In’ appear on the Teams calendar. You
will be able to drop in to the meeting by clicking ‘join’ from your calendar.

4. You will admitted to the meeting with the Learning Support Team as soon as they become
available*.

*Please note, due to student confidentiality, only one student will be admitted to the meeting at any one
time and therefore your patience is appreciated. In the event of large numbers of students wishing to
attend the drop in at one time, the learning support team will make a note of names and contact those
students on an individual basis.



3. Parent Drop In

In addition to the student learning support offer, parents also have the opportunity to attend our parent
‘drop in’ every Friday from 2.30-3.30pm to meet with the SENDCO, Mrs Banks to ask any questions
they may have about their child’s learning. The drop in does not replace any other line of communication
and parents may still contact staff via the school office, as appropriate. The parent drop in is provided as a
further means of support and communication during a school closure. The guide will describe how to
attend the parent drop in.

1. In your calendar in Teams, click ‘Meet Now’ in the top right corner.
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2. When the meeting screen appears, click ‘Join now’ — this will create your own meeting.
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3. In the patrticipants box, type in and select ‘Mrs C Banks’ or
cbanks@netherthorpe.derbyshire.sch.uk. Teams will then connect you to the drop in.

Participants

chankg

‘5‘ Mrs C Banks

Please note, due to confidentiality, only one parent will be admitted to the meeting at any one time and
therefore your patience is appreciated. In the event of long delays, please email Mrs Banks
cbanks@netherthorpe.derbyshire.sch.uk, who will be able to contact you at a separate time.
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4. A Guide to using ‘Speak’ User quide for PowerPoint

‘Speak’ is a tool to support people who have reading difficulties or have a diagnosis of
Dyslexia or Dyslexic tendencies. When switched on, it will read an entire document aloud to
you and allow you to access the PowerPoint more easily.

This guide will go through how to use ‘Speak’ in Microsoft PowerPoint.

1) When you open a document in Microsoft PowerPoint, do so as you would normally
do by double clicking on the document or by opening it in PowerPoint itself.
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2) When the document is open, you will need to go into the Quick Access Toolbar.
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4) Go to the Choose Commands from option and where it says_‘Popular Commands’ click on it.
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5) Go down the selection bar and click on_‘All Commands’
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6) Scroll down and find_‘Speak’ and click on it and then click on_‘add’ and then click on_‘ok’

\ |
PowerPoint Options \ / ? *
General o . .
E-E Customize the Quick Access Toolbar.
Proofing
Choose commandd from: (i Cusfomize Quick Access Toolbar (D
Save
| All Commands ‘ "l | F!r all documents (default) v|
Language I
Ease of Access o z:lje E:DW ‘?‘Etl L:JB E Save
) ~lde show Velupne Undo |»
Advanced I Slide Size » Redo
Customize Ribbon Sl?deS.orter‘u‘iew L® Start From Beginning
& Slide View L) Speak
Quick Access Toalbar Slides (&)
, Slides (&)
Add-ins Slides E]
Trust Center r|:'| Slides from Qutling..
Slides Per Page »
#  Small Eraser
ﬁ) Smart Lookup
ixg, Smarthrt
+,» SmartArt Colors »
FI:I SmartArt Layouts b
Smartirt Quick Styles! E]
SmartArt Size E]
S SmartArt Styles 3
:H: Snap to Grid
W' Snapto Shape |:|
] Seft Edges 3
] Soft Edges Options...
Sound 3

D Show Quick Access Toolbar below the Hstomizatians
Ribbon Import/Expert = |

| oK | | Cancel |

7) Do not click slide show and leave the PowerPoint as it is. Highlight the text on the
slide and then click on the speak button on the tool bar and it will say the
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5. A Guide to Immersive Reader in Microsoft Word.

Immersive Reader is a tool to support people who have difficulties with reading or have a
diagnosis of dyslexia or dyslexic tendencies. When switched on, the computer will read
an entire document aloud to you. This guide will go through how to use Immersive
Reader in Microsoft Word.

1) When you open a document in Microsoft Word, do so as you would normally do by
double clicking on the document or by opening it in Word itself.

I M 5 | Immersive Reader - O X

Home Share View o
v <« Home Drive (H:) » Immersive Reader v D Search Immersive Reader
<« H Drive (H:) | ive Read ¢ S Read
~
[ Thic PC A Name Date modified Type Size

) 3D Objects ﬂ;’J Immersive Reader 10/02/2021 11:44 Microsoft Word D... 13

I Desktop Type: Microsoft Word Document

|£| Documents Size: 12.4 KB

= Date modified: 10/02/2021 11:44

2) When the document is open, click on the View tab at the top of the screen, in the blue bar.
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3) When you go to the next bar within the View tab, go to the Learning
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4) On the next tab, you will need to click the Read Aloud tab and then a control bar will appear

on the right-hand side of the docurpe
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5) Click on the play buttgn  and the document will be read aloud. You
can pause it at any point uging the pause button .Asitis
read aloud, it will change the view of the document and the word that
is being read will be highlighted in grey.
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This document will be read aloud.

6) To end the Immersive Reader simply click on the Close Learning Tools button and you will

return to the document.
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6. Immersive Reader in Microsoft Teams

Immersive Reader is a tool to support people who have difficulties with reading or have a
diagnosis of dyslexia or dyslexic tendencies. When switched on, the computer will read an
entire document aloud to you. The great news is that Immersive Reader works in Teams
also, so can be activated during live lessons. This guide will go through how to use
Immersive Reader in Microsoft Teams.

1. Click on the team for your lesson and click files at the top of the screen.
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2. Double click on the file you wish to load, as you would normally. This will then load
your file.

3. Once the document is open, you will then be able to activate immersive reader by
clicking ‘view’ and then click ‘immersive reader.’
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4. Once Immersive Reader opens, click the play icon in the bottom centre of the
screen to start the reader.
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5. By clicking on the settings icon next to the play button, you can choose between a
male or female voice, as well a slowing down or speeding up the reader’s voice.
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7. Dictate Function in Microsoft Office

For those students who have difficulties with writing, the dictate option in Microsoft Word can
really support you.

1. Open a Word document in Office 365 and click ‘dictate’ in the top left hand corner of
the home tab.
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2. By pressing this icon, your laptop’s microphone will be activated and you will be able
to speak into your laptop which will change this into text for you. You will need to say
your punctuation out loud, e.g. ‘good evening, full stop’. If you do not have access to
a microphone on your computer, try using a headset or ear phone with a microphone
built in. Once recording, the mic in the bottom centre of the screen with turn red. To
stop recording, press the mic again.
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3. In Office 365, you can then use Immersive Reader to read the text back to you.
Highlight the text you want to listen to, click ‘view’ and then click ‘immersive
reader.’
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4. Once Immersive Reader opens, click the play icon in the bottom centre of the
screen to start the reader.
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5. By clicking on the settings icon next to the play button, you can choose between a
male or female voice, as well a slowing down or speeding up the reader’s voice.
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8. Color Vell

Working in front of a computer screen for extended periods of time can cause visual strain
and we can reduce this by applying a coloured tint to the screen. Tinting the computer
screen can also sometimes help students to read the text more successfully - particularly
for Dyslexic students or those diagnosed with Irlen Syndrome. Colour Veil is a free app
that students can load onto their computer to install coloured tints; students may need to
experiment with the different colours until they finds one that suits them best. The link to
the installation is: ColorVeil - Screen color filter and dimmer | Aurelitec

1) On the Color Veil Website www.aurelitec.com/colorveil/ , click ‘Download EXE’. This will
then save to your downloads folder.

2) Once in downloads, double click the color veil icon to open the programme.

3) This will open the programme and you will be given the pop up box below. Click Run
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run this software?
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4) You will then get another pop up box stating that the programme will be running in the
tool bar at the bottom right hand side of the screen (the screen may change colour)

-
u Welcome to ColorVeil @

The CelorVeil icon is in the notification area, at the far right of the taskbar.

Left-click to toggle the veil, right-click to open Settings.
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6) To access the programme you need to right click on this icon and it will open the
following box;
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7) From here you can change the colour of the screen to suit your individual needs

8) If you Quit the programme then you will have to go through this process again, it is
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9. Additional Support for Students:

In addition to the information and support set out, if a parent or student has concerns about their
learning, please contact Mrs Banks or Mrs Cundy via the school office. Following a discussion about
the student’s difficulties, we may offer suggestions to links to support their learning, send additional
re-sources and/or arrange for a TA to contact the student via telephone or a Microsoft Teams
meeting.

IDL Reading, Spelling and Numeracy Support

At Netherthorpe, we are fortunate to be able to offer the IDL literacy and numeracy intervention
package to our students. IDL is an online intervention which focuses on reading, spelling and
numeracy. You can access IDL via: https://idlsgroup.com/

We recommend that your child uses IDL for 15 minutes per day — IDL research suggests that on aver-
age a child’s reading and spelling ages increase by 11 months after only 26 hours of use! Your child
may already have an IDL log on, but if not or if they have forgotten their details, please email Mrs
Banks and | will be happy to reset their log on details.

cbanks@netherthorpe.derbyshire.sch.uk

Social Skills: Independent Living

The National Oak Academy has developed a series of lessons focusing on independent living skills
for secondary school students. These focus on 6 key areas: home management, personal care, daily
living skills, community living, world of work and staying safe. SEND students may find it useful to
work through these 6 units and develop their understanding of independent living as part of their
preparation of adulthood pathway. These lessons can be accessed via the link below:
https://classroom.thenational.academy/specialist/subjects/independent-living

The National Oak Academy

The National Oak Academy has a library of recorded lessons to support students learning in a variety
of different subjects. Students can access these lessons freely, pause them to allow for thinking time
and replay them to benefit their retention of the content. | would encourage you and your child to
explore this library and access these lessons to support their remote learning. The National Oak
Academy has a ‘Specialist SEND Classroom’ section, and although not all lessons on there are aimed
at Secondary age students, there are resources and activities available that some students with
SEND may find useful.

https://www.thenational.academy/

BBC Bitesize Parents’ Toolkit: SEND

This section of the website is aimed at providing parents with a wealth of information and support to
enable them to best meet their child’s needs at home, be that Dyslexia support, advice for supporting
students with ADHD and/or Autism and also support in terms of emotional wellbeing or how to support
a child who may be feeling anxious. Please take a good look through these resources. Again, some
are aimed at younger children, but there is a wealth of support and advice for parents on these pages.
https://www.bbc.co.uk/bitesize/articles/zh9v382

Chatter Pack

Chatter Pack is a voluntary-run SEND Hub which has a wealth of free and purchasable resources to
support academic learning and also a student’s emotional wellbeing. In addition to the free re-sources
and those available for purchase, Chatter Pack have put together a resource list as part of their blog.
This resource list covers many areas of SEND and has links to activities to further support a child’s
specific SEND. The resource list and blog as be accessed via:

https://chatterpack.net/blogs/blog

Please contact Mrs Banks (SENDCO) or Mrs Cundy (Assistant SENDCO) via the school
office or email if you have any questions or require additional support. 01246 472220
cbanks@netherthorpe.derbyshire.sch.uk or scundyl@netherthorpe.derbyshire.sch.uk
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